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In this session you will: 

✓ gain an overview of the meaning and origins of word 
processing 

✓ gain an overview of the common types of documents that 
can be word processed 

✓ learn how to start Word from the desktop 

✓ gain an understanding of the Word 2016 Start Screen 

✓ learn how to create a new blank document 

✓ gain an understanding of the Word 2016 screen 

✓ gain an understanding of how Word 2016 works 

✓ learn how to use the ribbon 

✓ gain an understanding of Backstage View in Word 

✓ learn how to use shortcut menus 

✓ gain an understanding of how dialog boxes work 

✓ gain an understanding of the Quick Access Toolbar 

✓ gain an understanding of the status bar 

✓ learn how to exit correctly and safely from Word. 

Microsoft Word is a word processing application that is usually part 
of a suite of Microsoft applications, known as Microsoft Office. 

You can use Word to create all sorts of documents, including 
letters, reports, faxes, forms, emails, web pages, invitations and 
certificates. 

Before you leap into creating anything, it is worth taking some time 
to become familiar with the Word window and its features. 

INFOCUS 
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UNDERSTANDING WORD PROCESSING 
 

 

 

 

  

 

Every facet of our everyday existence is 
controlled by the written word. We receive 
information, follow instructions and record events, 
often using documents that consist of carefully 

chosen words. The ability to create these 
documents, to change them, to enhance the way 
they look, and to print them is what is now referred 
to as word processing. 
 

Word Processing – A Definition 

Word processing refers to the ability to create, edit and store text, and to reprint it as many times as 
desired. Word processing is used to create a multitude of personal and business documents, such as 
letters, memos, faxes, reports, books, essays, brochures, flyers, price lists, and the list goes on! 

The Roots of Word Processing 

The desire for humans to communicate in writing can be traced back to our cave dwelling ancestors who 
painted images of hunting and everyday life on cave walls. Who knows, these might even have been the 
first training manuals or reports on hunting expeditions! 

The ancient Egyptians used writing to record commercial trading transactions. Initially using clay and 
stone, they then invented writing on paper, or papyrus, to speed up the process of writing. 

In 1492 Johannes Gutenberg invented the world’s first printing press which allowed one document to be 
produced and disseminated many times. Many historians attribute world-shaking events such as the 
English, French and American revolutions to the invention of printing and the communication of ideas. 

The printing press marked the beginning of using machines to produce writing. This idea of using 
machines for writing was kicked on in 1873 when Christopher Latham Scholes invented the first 
commercially-practical typewriter. This typewriter was marketed by the Remington Arms company. 
Earlier experimental typewriters used an alphabetical keyboard. However, the action of the type bars in 
these machines was sluggish and the bars tended to jam. Scholes developed the QWERTY keyboard so 
that letters used in combination were further apart, therefore allowing more time for the type bars to 
return to their normal position and avoid jamming. In 1878 ten-finger typing was established using the 
QWERTY keyboard – essentially, this has meant that the QWERTY keyboard has survived to this day 
even on modern computers. 

Typewriting gained enormous popularity in offices around the world in the first half of the twentieth 
century. New office procedures and jobs were created around the typewriter – many organisations had 
special typing pools, which consisted of teams of people (usually young women) typing documents. 

In 1961 IBM introduced the Selectric typewriter. It was an electric typewriter with fewer moving parts 
than a manual typewriter, and was much faster to use. In 1964 IBM released the Magnetic Tape 
Selectric Typewriter that allowed typed information to be stored and retrieved. This machine was 
marketed as a word processing machine because for the first time text could be stored, replayed (typed 
automatically from the tape), changed and printed as many times as required. 

In 1972 Lexitron and Linolex introduced the first modern word processing system which displayed 
documents on a screen rather than on paper. This machine stored the documents on cassettes. The 
screen allowed text to be entered, rearranged or deleted without the need for producing a paper copy. 

In 1973 IBM released a new word processing machine that stored documents on floppy disk. Early 
storage systems could hold only several pages. The floppy disk allowed the storage of large, multi-page 
documents. The word processors were special machines designed specifically for producing documents. 

In 1981 IBM released the IBM Personal Computer which used floppy disk storage technology. This was 
one of the few machines ever invented in history that had no specific purpose. It soon became apparent 
that the programs used in word processing machines could be stored on floppy disk. Once stored on 
floppy disk they could be used in personal computers, thus converting the personal computer to a word 
processing machine. 

This concept has grown and is the underlying basis of modern word processing. Programs such as 
WordStar, DisplayWrite, WordPerfect and later, Microsoft Word, emerged, allowing the personal 
computer to produce documents with a size and complexity far greater than earlier machines. Today, 
virtually all word processing is done on personal computers using word processing programs. 
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TYPES OF WORD-PROCESSED DOCUMENTS 
 

 

 

 

  

The first word-processed documents were 
business documents such as letters, memos and 
reports. With the development of screen and print 
technologies, it is now possible to use word 

processing software to produce a much greater 
variety of documents such as brochures, 
newspapers and newsletters, greeting and 
business cards, and more. 
 

Type Characteristics Intended Audience 

Letters Letters are usually one or two pages in length and consist 
mostly of text 

Business associates, 
customers, suppliers, 
friends, relatives, etc 

Memos Memorandums are internal business documents that usually 
consist of one or two pages of text 

Fellow employees, 
management, 
subordinates 

Faxes Faxes are documents transmitted over telephone lines. They 
are usually brief and are used to convey information quickly and 
succinctly. Faxes can be printed and sent from a fax machine or 
they can be sent in electronic format directly from a computer 
connected to a telephone line 

Business associates, 
customers, suppliers 

Reports Reports are normally multi-page documents providing 
information or findings of an investigation or survey to the 
reader. They usually consist of text. Long reports may also have 
a table of contents and an index 

Business associates, 
clients, management, 
creditors, shareholders, 
general public, 
community groups, etc 

Briefing 
Papers 

Briefing papers are documents that provide background and 
useful information regarding an historical or upcoming event 

Sales people, managers, 
committee members, 
company board 
members, etc 

Minutes Minutes records what officially went on in a meeting. They can 
be informal or formal and basically describe what was 
discussed, what decisions were made, what actions need to be 
taken, and who is responsible for carrying out those actions 

Attendees and other 
interested parties 

Essays and 
Assignments 

Essays and assignments are normally multi-page documents 
conveying ideas, opinions or research findings. They mostly 
consist of text 

Teachers, lecturers, 
mentors 

Training 
Manuals 

Training manuals are normally multi-page documents designed 
to instruct and inform. They range from mostly text to highly 
structured documents. (Note: this publication was produced 
using Microsoft Word) 

Course attendees, 
people wishing to acquire 
new skills and 
knowledge, people 
wishing to gain a 
qualification or 
accreditation 

Books Books are multi-page documents consisting mostly of text. They 
have a table of contents and usually an index 

People seeking 
information and/or 
entertainment 

Brochures Brochures are mostly laid out with graphics and text. They are 
often no more than several pages in length. Increasingly, these 
are transmitted electronically via the internet 

Clients, potential 
customers 

Newsletters Newsletters are used to convey news, updates and activities for 
clubs, groups, organisations, products, and the like. They are 
organised into columns and consist mostly of text 

Clients, customers, 
general public, club 
members, etc 

Flyers Flyers are normally one-page information sheets that are highly 
graphical and structured advertising a product or event 

Clients, potential 
customers, club 
members, etc 

Emails Emails are usually short letters sent via the internet or through a 
computer network 

Anyone with an email 
connection 
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STARTING WORD FROM THE DESKTOP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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 Before starting this exercise 

ensure the computer is 
switched on… 

 
If there is no Word icon in the 
taskbar at the bottom of the 
desktop, click on the Windows 
icon in the taskbar, as shown, 
to display the Start menu 

 
Click on All apps to display a 
list of all the apps on your 
computer 

 
Scroll down to the W section 

Word 2016 is listed here… 

 
Click on Word 2016 to start 
Word 

 
Right-click on the Word icon in 
the taskbar to display a menu 
of options, as shown, then 
select Pin this program to 
taskbar 

You can now click on this icon 
to open Word from the 
desktop. This icon will remain 
in the taskbar unless you 
remove it… 

 
Repeat step 5 to select Close 
window to close Word 

 
Click on the Word icon in the 
taskbar to open Word again 

 

1 

To create or edit a workbook, the first thing you 
must do is start Word. The first time you use 
Word you will need to open it from the taskbar 
Search the web and Windows bar or the All 

apps list in the Start menu. You can then choose 
to pin it to the Start menu or the taskbar so that 
you can access it more quickly and easily the next 
time you use it.  
 

For Your Reference… 

To add a Word icon to the desktop taskbar: 

1. Display the Start menu, then click on All 
apps 

2. Right-click on Word 2016 

3. Select Pin to taskbar 

 

Handy to Know… 

• You can start Word by clicking in the taskbar 
Search… bar, typing word, then clicking on 
Word in the list of search results. 

• You can pin Word to the Start menu by 
displaying the All apps list, right-clicking on 
Word 2016 and selecting Pin to Start. 
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UNDERSTANDING THE START SCREEN 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Most times you open Word, a start screen will 
display. From this initial screen, you can choose 
what kind of document you want to work with. 
You can choose to work with one of your most 

recently accessed files, open a document which 
has been saved to Computer or OneDrive or 
create a new document using the available 
templates.  
 

Microsoft Word 2016 Start Screen 

The Microsoft Word 2016 Start screen is very helpful if you want to quickly access files you have worked 
on recently or create a new document based on one of the available templates (including the default 
Blank document template). 

If you have already worked on a document or several documents in Word, a list of recent files will display 
below Recent in the blue pane to the left of the screen. If you haven’t worked on any documents yet, you 
can still open existing documents by clicking on the link, Open Other Documents, located below 
Recent. This lets you open an existing file from your computer or OneDrive.  

The main pane of the start screen displays available templates you can use to create a new document 
and a search box you can use to search the internet for additional templates. Templates are simply 
layouts that have already been created which you can customise to suit your needs and then enter 
relevant content. If you want to start with a clean slate you can choose the Blank document template – 
you’ll probably find this is the one you will use the most. 

In the top right corner of the screen you’ll see information about the account you’ve used to sign into 
Windows as well as help, minimise, restore down, and close tools. 

 

 

The start screen will only display when you launch the Word 2016 application directly – that is, by 
clicking on the Word tile on the Windows 10 Start screen, clicking on the application on the Apps 
screen or under search results, or clicking on the taskbar icon if the application has been pinned to the 
desktop Taskbar.  

Word 2016 can also be started in Windows 10 by double-clicking on a Word document in File 
Explorer. When this occurs Word 2016 will start with the document open on the screen and the start 
screen shown above will be bypassed.  
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CREATING A NEW BLANK DOCUMENT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 F
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e
 Before starting this 

exercise you MUST 
ensure the Microsoft 
Word Start screen is 
displayed… 

 
Click on Blank 
document (the first 
option beneath the 
title, Featured) 

A new blank 
document will open. 
Notice that the 
document is 
automatically 
assigned a 
temporary name, 
which is displayed in 
the Title bar 
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For Your Reference… 

To create a Blank document: 

1. Open Word so that the start screen is 
displayed 

2. Click on Blank document in the list of 
templates  

Handy to Know… 

• If you already have a document open and 
want to create a new one, click on the File 
tab to open Backstage view, click on the 
New tab and then select Blank document. 

• You can also use the keyboard shortcut  

+  to instantly open a new document 

based on the Blank document template. 

When you want to create a letter, shopping list, 
annual report or anything with words in it for that 
matter, you will first need to create a document. 
All documents created in Word are based on a 

template. A template defines the basic layout of a 
document. To create a simple document, you are 
able to base it on the Blank document template 
installed with Word. 
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THE WORD SCREEN 
 

 

 

 

  

 

The Microsoft Word screen is made up of several 
key components which are described on this page. 
Some of these components, such as the ribbon 
and Backstage view, are common to all other 

Office 2016 applications so once you know how they 
work you won’t have to relearn them when you use 
other applications. 
 

 

 
The File tab is used to access the Backstage view which contains file management functions, such as 

saving, opening, closing, printing, sharing, and so on. There is also information contained here such as 

your document Properties. Options are also available so that you can set your working preferences for 

Word. 

 
The ribbon is the tabbed band that appears across the top of the window. It is the control centre of 

Word. You use the tabs on the ribbon to access the commands that are categorised into groups. The 

commands include galleries of formatting options you can select from, such as the Styles gallery shown 

above. 

 
The Insertion point shows where the text will appear if you start typing. 

 
The Mouse Pointer is used, amongst other things, to move the insertion point to different locations in the 

document. It may appear as a pointer or an I-bar, as in this example, or any number of other forms, 

depending upon its function at that position on the screen. 

 
The Status bar appears across the bottom of the window and displays the current location of the 

insertion point, page number and word count. You can access additional information such as Section 

number, Column number, and so on, by right clicking on the Status bar.  

 
Dialog box launchers are positioned in the bottom right corner of some groups of commands on the 

ribbon. Clicking on a dialog box launcher opens a dialog box with additional options relating to that 

group of commands. 

 
The Scroll bar indicates your current position in the document and lets you move to other positions in 

the document by clicking or dragging the bar. The arrows can also be used to move through the 

document. 

 
The View buttons and the Zoom slider are used to change the view and to increase or decrease the 

zoom ratio for your document. 

 

1 

2 

3 
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HOW MICROSOFT WORD 2016 WORKS 
 

 

 

 

  

 

The Word 2016 screen has three key areas. The 
data you type is placed on a page. The data can be 
manipulated using commands on the ribbon. The 
page is part of a larger entity known as a document 

or file, and changes to the file are controlled in 
Backstage view. These key components are 
described on this page.  

 

The Page 

If you create a new blank document, it will 
appear as a blank page in the document 
window with a blinking insertion point. When 
you start typing, the text will appear at this 
location. You can also create a new 
document from a template, such as this 
resume shown to the right, where specific 
information will appear by default on the 
page, and you can edit it and add your own 
data as desired.  

 

The Ribbon 

When you need to do something with the 
data on a page, such as format it, colour 
it, move it, copy it, and much more, you’ll 
find all of the relevant commands on the 
ribbon. The ribbon has the commands 
organised thematically using a series of 
tabs across the top. 

 

Backstage View 

When you want to do something with 
the data in your document, such as 
save it so that you can access it again 
later, print it, share it with a colleague, 
send it to your boss, protect it from 
prying eyes, or whatever, you will need 
to access the Microsoft Office 
Backstage view of Microsoft Word. 
Backstage view is accessed using the 
File tab on the ribbon. Rather than 
displaying commands on a ribbon, 
Backstage occupies the entire screen 
and has a series of tabs down the left 
side which allow you to perform a 
number of operations. In our sample to 
the right, the Print tab is active, and 
that is why you can see a preview of the 
document and a number of print-related 
options on the screen. 
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USING THE RIBBON 
 

 

 

 

 

 

 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

 

Before starting this exercise, 
you MUST ensure that Word 
has started and a new 
document is displayed… 

 
Examine the groups on the 
Home tab 

These are the most commonly 
used commands... 

 
Click on the Insert tab 

The commands on this tab are 
used to create pages, tables, 
illustrations, comments, 
headers and footers, text 
objects and equations and to 
add things such as apps and 
media to your document... 

 
Click on Shapes in the 
Illustrations group to display 
the Shapes gallery  

This gallery includes a huge 
range of shapes as well as the 
menu option New Drawing 
Canvas... 

 
Click on each of the tabs and 
examine the commands 

Some of these open ‘dialog 
boxes’... 

 
On the View tab, click on 
Zoom in the Zoom group to 
open the Zoom dialog box 

 
Click on [Cancel] then click on 
the Home tab 

 

1 

For Your Reference… 

To use the ribbon: 

1. Click on a tab to display the commands 

2. Click on a button to activate a command, 
display a gallery or display a dialog box 

Handy to Know… 

• Additional tabs known as Contextual tabs 
appear in specific circumstances. For 
example, if you insert a picture, the Picture 
Tools: Format tab will appear. This provides 
quick access to all of the tools you may need 
to modify and work with the picture. 

The ribbon is the command centre for Word. It 
provides a series of commands organised into 
groups that are placed on relevant tabs. Tabs 
are activated by clicking on their name to display 

the command groups. Commands are activated by 
clicking on a button, tool or gallery option. 
Everything you could possibly want to do in Word 
will be found somewhere on this ribbon. 

3 
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UNDERSTANDING THE BACKSTAGE VIEW 
 

 

 

 

  

 

The ribbon lets you work on the content in a 
document so that you can add more content, format 
it, insert pictures into it, copy it, and much more. 
The Backstage view, which is accessed using the 

File tab, lets you do something with the content you 
create. You can save it for later use, print it on paper, 
send it via email, and more by using the options found 
in Backstage 

The Backstage View 

The File tab on the ribbon is not a normal tab – as you can tell by the fact that it is coloured. Clicking on the File tab 
launches a mini-program within Microsoft Word known as Backstage view. Backstage, as it’s known for short, 
occupies the entire screen. 

At the left of the Backstage is a navigation pane which is made up of tabs. These tabs provide you with access to 
various operations, such as printing, saving and sharing. They can also provide you with information about your 
document such as the file size. 

Clicking on one of these tabs brings up a range of options associated with the particular operation. 

The whole underlying purpose of Backstage is to let you protect your data, share it with others, and 
provide you with valuable information about your document. Depending on what type of document it is 
and what has been done to it, different information may display when the Info tab is selected. 

 

Backstage Tabs 

  The Backstage tabs provide more options for working with a document 

Info Provides status information about the current document and lets you 
manage versions and permissions. 

New Lets you create a new document and provides access to a gallery of 
inbuilt templates as well as ready access to a range of online 
templates. 

Open Provides a list of recent documents as well as the option to search 
through your Computer, OneDrive or other place, to find what you 
are looking for. 

Save Saves your current document (if already saved to a location) or 
prompts you to save to a location. 

Save As Allows you to name your document and save it to a location. 

Save as 
Adobe PDF 

Allows you to save a Word document in the format of a PDF for 
viewing in Word or PDF readers. 

History When this option is greyed out as in the example to the right, it is 
unavailable. However when it appears white you can select it to view 
the version history of the file you are working on. 

Print Lets you print the current document and preview it. 

Share Lets you share your document with other people via email, online 
presentation, blog or Cloud (OneDrive). 

Export Allows you to create a PDF/XPS document or change the file type of 
your document. 

Close Closes your current document. 

Account Contains product and user information. 

Options Presents you with a range of options which assist in the creation and 
editing of your document. 

Feedback Allows you to send feedback on Word to Microsoft. 
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USING SHORTCUT MENUS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 

 

Before starting this exercise 
ensure you have a blank 
document open… 

 
Point to the middle of the 
document and click with the 
right mouse button to display 
a shortcut or contextual 
menu 

Because you have clicked in 
the body of the document, the 
menu includes Font and 
Paragraph options. As no text 
is actually selected the Cut, 
Copy and Paste options are 
greyed out as they are 
unavailable… 

 
Click anywhere on the page 
with the left mouse button to 
close the shortcut menu 

 
Point to any of the tabs on the 
ribbon 

 
Right-click on a tab to display 
a shortcut menu 

This menu differs from the 
previous one and displays 
toolbar and ribbon options 
instead of text options. Word 
has made an educated guess 
about what you want to do 
based upon what you have 
clicked... 

 
Click anywhere on the page 
with the left mouse button to 
close the shortcut menu 
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For Your Reference… 

To display a shortcut menu: 

1. Point to the object or area of the screen on 
which you want to perform an operation 

2. Right-click to display the shortcut menu 

In addition to the ribbon, Word also features 
shortcut menus that appear when you right-click 
in an area on the screen or on an object. The 
content of the menu will vary depending on 

where you click. Shortcut menus provide an 
alternative (and usually quicker) way to searching 
through the ribbon to find a specific operation or 
command. 

Handy to Know… 

• Once a shortcut menu appears, the options 
in it are selected by clicking on them with the 
left mouse button. 
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UNDERSTANDING DIALOG BOXES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dialog boxes contain a series of controls that 
are used to adjust settings for a particular aspect 
of a document. They appear either when you 
click on a dialog box launcher at the bottom 

right corner of a group on the ribbon, or when you 
click on a command that displays a dialog box. 
Dialog boxes are often used for adjusting some of 
the more advanced aspects of a document. 

Typical Dialog Box Controls 

Dialog boxes have various tools to help you perform tasks. These tools are known as controls and 
some typical ones are shown below. 

 

Tabs are used to 
provide more 
settings on the one 
dialog box. 

Drop arrows 
provide a list of 
options for the text 
box when the arrow 
is clicked. The list 
“drops down” from 
the arrow. 

Text boxes are 
used to enter text 
such as font or size.  

 

Check boxes turn 
settings either on or 
off. When settings 
are on the checkbox 
displays a tick and 
therefore these 
controls are also 
known as tick boxes. 

 

Command buttons provide a means of saving the 
changed settings [OK], or closing the dialog box 
without accepting any changes made [Cancel]. 

Preview boxes 
provide a preview of 
what the selected 
settings will look like. S
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